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VEN-126 Corridor
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VEN-126 Corridor
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VEN-126 Corridor



5

VEN-126 Corridor – Hallock Dr

No link on the 
south end!
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Options to Address
Look for existing data?
» Traffic study counts, forecasts

Manually allocate TAZ Centroid Volumes?

Consider disaggregating zones
» Tier 1  2
» Custom splits beyond Tier 2?
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Relevant Zones/Centroids

One TAZ centroid 
matched with 5 
interchanges!
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Relevant Zones/Centroids

Multiple (6) Tier 2 
zones/connectors…

Not all in the right 
place

Near (not at) 
Hallock
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Using model growth?
Tier 1 CC is the best bet if we have no 
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Existing Data/Studies
Use existing count data as available

Work with local jurisdictions to determine 
growth plans
» Traffic studies?
» Land use plans (General or specific plans)
» Jurisdiction staff knowledge?
» Use model growth % and apply to count?

Evaluate options and select the most 
reasonable

Last 
Resort!

Other 
methods 

better
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Manual Allocation
Identify travel-shed to interchange based on 
Tier 2 Zones

Look at Tier 2 Mode Choice results to 
approximate share of Tier 1 Connector

Use this share as an estimate for the missing 
intersection leg
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Subarea Modeling
Adjust Centroid connector placement

Are Tier 2 zones the right geography
» If not, consider making further refinements

Identify % share of trips in each
» Use Tier 2 Mode Choice results, vehicle trips
» Origins and Destinations vs. 

Productions and Attractions! (Future Topic)

Revises network and OD matrix files

Assign the disaggregated matrix

Split T2 
zones, 
don't 
move 

borders
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Subarea Matrix Expansion

Expand

Original T1 Expanded T2
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Subarea Options
Simplest (often best in this case):
» Expand the OD table and run assignment only

More difficult:
» Update complete SCAG model
» Make subarea Tier 2 or custom zones "Tier 1" in a 

modified model
» Borrow zones from elsewhere, or attempt to add to 

the total
» Run either full feedback or a single loop
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)
» Define project links 
» Extract data from traffic assignment results

Apply a factor to adjust modeled traffic volumes, and 
update the congested speed (Practice 3)

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2), and update the congested 
speed (Practice 3)

In previous version of the AQ Tool

New function added to the AQ Tool

New function added to the AQ Tool
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2035 Adj No Build*

Interpolation

* Need to apply a factor

Data Extraction

Interpolation Applying a 
Factor

Data Extraction
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Input

SCAG highway network
» Define project links
» Obtain the link attributes

Excel file 
» Output template
» with description of the project links

Traffic assignment bin files
» Modeled volume
» Congested speed
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Data Extraction Directly from 
the SCAG Model
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Flow Chart (Data Extraction)

Data Extraction

Output Files 
(Bin format) 

Project Link List with 
Link Attributes  

Traffic Assignment Bin 
File

Final Output

Template

Output Files 
(CSV format) 

Presenter
Presentation Notes
Two files from Jonathan
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Output

Four CSV Files
» Two freeway csv files, one for each direction
» One ramp csv file
» One arterial csv file

Copy to the Excel Template File
» Copy values only
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Exercise 1: Run the AQ Tool

Install the AQ Tool (TransCAD Add-ins)
Run the function “Data Extraction”
Examine the results
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Exercise 1-1: Install the AQ Tool
Step 1: In TransCAD, click Tools  Setup Add-Ins

Step 2: In the Setup Add-ins 
window
» Click the button “Add”
» For Settings  Type, select “Dialog Box” 
» For Settings  Description, enter a 

description of the tool
» For Settings  Name, enter “Air Quality 

Data Extraction” (must be exactly the 
same, case sensitive, no quotation marks)

» Click the “Browse” button to specify the UI 
Database, which is 
“d7_airquality_dataextraction.dbd” in the 
folder of “\Tool”.

» Click the “OK” button to close the window.
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Exercise 1-2: Run “Data Extraction”
Step 3: Select the AQ tool from Tools  Add-Ins 

Step 4:  On the “Data Extraction” tab, specify the inputs and output 
folder, and click “Run” to run the tool
» Project Link ID file is “\SR_126\Input\Project Link List for SR-126.bin”
» SCAG Traffic Assignment Folder is “\SCAG 2012RTP 2008 BY 

Scenario\Assign\Outputs\”
» Output Folder is “\SR_126\Output_2008\”

Presenter
Presentation Notes
Project Link ID file is “\SR_126\Input\Project Link List for SR-126.bin”
SCAG Traffic Assignment Folder is “\SCAG 2012RTP 2008 BY Scenario\Assign\Outputs\”
Output Folder is “\SR_126\Output_2008\”
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Exercise 1-3: Create the Final Output
Step 5: Open the csv files* in Excel and copy values to the 
corresponding spreadsheet in the template Excel file 
“\SR_126\SR-126 Air Quality 2008.xlsx”

Tips
» When copy from the CSV file, use Ctrl + Shift + 

(pressing three keys together) on the keyboard to 
select all columns, then use Ctrl + Shift + ↓ to 
select all rows

» When paste to the Excel file, paste values only to 
preserve the format in the Excel file. To do that, 
right click the cell where you want to paste in Excel 
and choose      in the popup window. 
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Exercise 1-4: Run the 2035 Scenario

Repeat Exercise for the 2035 Baseline. The SCAG 
Traffic Assignment Folder is “\SCAG 2012 RTP 2035 
Baseline Scenario\Assign\Outputs”



13

Applying a Factor
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Flow Chart (Applying a Factor)

Applying a Factor

Output Files 
(Bin format) 

Output File from Data 
Extraction (Bin format)  SCAG Working Network

Final Output

Template

Output Files 
(CSV format) 

Factor

Presenter
Presentation Notes
Two files from Jonathan
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Exercise 2-1: Run “Apply a Factor”

Step 1: Select the AQ tool from Tools  Add-Ins 
Step 2:  On the “Apply a Factor” tab, specify the inputs and 
output folder, and click “Run” to run the tool

» Data Extraction File to Adjust is 
“\SR_126\Output_2035\Project Link List for SR-
126_temp.bin”

» SCAG Network Working File is “\SCAG 2012 RTP 2035 
Baseline 
Scenario\networks\Outputs\scag_network_working.bin”

» Output Folder is “\SR_126\Output_2035_Factor\”
» The adjustment factor is 1.59849
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Exercise 2-1: Run “Apply a Factor”
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Exercise 2-2: Create the Final Output

Open the csv files* in Excel and copy values to the 
corresponding spreadsheet in the template Excel file 
“\SR_126\SR-126 Air Quality 2035.xlsx”
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Interpolation and Extrapolation
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Flow Chart 
(Interpolation/Extrapolation)

Interpolation / Extrapolation

Output Files 
(Bin format) 

Output File 1 from Data 
Extraction (Bin format)  SCAG Working Network

Final Output

Template

Output Files 
(CSV format) 

Forecast 
Year

Output File 2 from Data 
Extraction (Bin format)  

Presenter
Presentation Notes
Two files from Jonathan
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Exercise 3-1: Run “Interpolation and 
Extrapolation”

Step 1: Select the AQ tool from Tools  Add-Ins 
Step 2:  On the “Interpolation and Extrapolation” tab, specify the 
inputs and output folder, and click “Run” to run the tool

» Year 1 is 2008, the Data Extraction File is 
“\SR_126\Output_2008\Project Link List for SR-126_temp.bin”

» Year 2 is 2035, the Data Extraction File is 
“\SR_126\Output_2035_Factor\Project Link List for SR-
126_temp_Factor.bin”

» SCAG Network Working File is “\SCAG 2012 RTP 2035 Baseline 
Scenario\networks\Outputs\scag_network_working.bin”

» Output Folder is “\SR_126\Output_2022\”
» Year to interpolate or extrapolate is 2022
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Exercise 3-1: Run “Apply a Factor”
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Exercise 3-2: Create the Final Output

Open the csv files* in Excel and copy values to the 
corresponding spreadsheet in the template Excel file 
“\SR_126\SR-126 Air Quality 2022_Interpolate.xlsx”
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Prepare the Project Link ID 
Input File
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Exercise 3: Prepare Input Files

In Excel, add records
Remove records
Re-order records
Export to CSV files, correct the files in 
Notepad++
Export to Bin files and modify the data 
type in TransCAD
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Prepare the Project Link ID Input 
File in TransCAD

Step 1: Navigate to the Project Location
» Purpose: Open the highway network and display project links
» TransCAD operations: 

 Open a geographic file 
 Navigate a map
 Show the node layer

Step 2: Assign and review project link IDs
» Purpose: Assign project link IDs to each link to be included in the AQ

analysis
» TransCAD operations: 

 Add a new field in the link attribute table
 Use the “info” tool to enter new link attributes
 Create a selection set by condition
 Create labels
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Prepare the Project Link ID Input 
File in TransCAD (continued)

Step 3: Save the dataview as a *.bin file
» Purpose: Clean and organize the highway network dataview to show 

only what will be saved as a *.bin file
» TransCAD operations:

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Save a dataview as a *.bin file

Step 4: Modify the table – add fields, rename fields, and 
re-organize fields
» Purpose: Make sure the project ID input file has the same fields as what 

was used for the SR-126 and the SR-118 examples. 
» TransCAD operations: 

 Add new fields
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SR - 118

Presenter
Presentation Notes
16 miles long
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Step 1 : Navigate to the Project 
Location

Purpose: Open the highway network and display 
project links

TransCAD operations: 
» Open the geographic file 

\AQ Training Material\SCAG 2012RTP 2008 BY 
Scenario\networks\Outputs\ scag_network_working.dbd

» Navigate the map
» Show the node layer
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Step 2: Assign and review project 
link IDs

Purpose: Assign project link IDs to each link to be included in 
the AQ analysis

Detailed Steps:
1. Add a new field “Proj_Link_ID” in the link attribute table
2. Select the 13 project links by pointing on each link
3. Use the “info” tool to enter “Proj_Link_ID” for each of the 13 links
4. Label “Proj_Link_ID” on the 13 links

Hints:
1. Dataview  Modify Table

2. Selection Toolbox 

3. Main Toolbox 
4. Selection Toolbox  
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Project Link IDs used in the Practice
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Step 3: Save the dataview as a 
*.bin file

Purpose: Clean and organize the highway network dataview to 
show only what will be saved as a *.bin file
Detailed Steps:
1. Show only records of interest
2. Show only fields of interest (“ID”, “Length”, “Proj_Link_ID”, “Road 

Name”, and “Road Type”)
3. Sort records in TransCAD by “Proj_Link_ID”
4. Save the dataview as a *.bin file

File  “Save As”  save as type *.bin 
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Step 4: Modify the table – add fields, 
rename fields, and re-organize fields
Purpose: Make sure the project ID input file has the same fields as what 
was used for the SR-126 and the SR-118 examples. 

Hints:
1. Can add fields, rename fields and re-organize fields by 

Dataview  Modify Table

2. Rename “ID” to “SCAG_Link_ID”, “Proj_Link_ID” to “Project_Link_Number”, and “Road 

Type” to “Facility_Type”. 

3. Make sure “Facility_Type” is “Fwy –MF” for freeway links, and contains the word “Ramp” 

or “ramp” for ramp links.

4. Add a new “ID” field, whose values are sequential from 1 to the number of project links. 

5. All other fields in the SR-126 and the SR-118 examples are optional, but may be very 

helpful. Users can also add his/her own fields for a better description of the links.
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Overview of the SR-126 
Project
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SR - 126
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The SR-126 Project

Project limit
» SR-126 from SR-150 to SR-23

Project
» Convert SR-126 from “continuous left turn arterial” 

to “fully divided arterial”

Opening Year
» 2022

Future Year
» 2040
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Links for the SR-126 Project 
AQ Analysis 

Presenter
Presentation Notes
16 miles long
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What Links should be included for 
an AQ Analysis

Project links 
Links connected to project links 
» Usually include links that are within one intersection of the 

project links

Optional: Links on alternative routes
» A project might introduce more traffic on project links due to 

higher capacities or free flow speeds, therefore leading to 
more Vehicle Miles Traveled (VMT) and possibly more 
emission. 

» However, this project should have reduced traffic on 
alternative routes, and then less emission on alternative 
routes. 

» In this situation, it is better to include links on alternative 
routes in the AQ analysis. 



7

Overview of the Air Quality 
Analysis Process
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Air Quality Analysis Data Needs

Key information for an Air Quality (AQ) 
analysis

» Total Volume
» Truck Percent
» Congested Speed
» Vehicle Miles Traveled (VMT)
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Air Quality Analysis Data Needs
AQ Data for a Project 

Base Year

Opening Year No Build

Opening Year Build

Future Year No Build

Future Year Build

Base Year (2008 for SR-126)

Opening Year (2022 for SR-126)

Future Year (2040 for SR-126)
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SCAG Model Alternatives
AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build*

SCAG 2035 Build*

* For the SR-126 project, the official SCAG 2035 
model is the no build scenario, and a SCAG 
2035 build scenario model needs to be run (the 
traffic assignment step only).   
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build*

2040 Build*

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Interpolation

Interpolation

* See the next slide
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Extrapolation

Extrapolation
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2)

Update congested speeds for the interpolated / 
extrapolated traffic volumes (Practice 3)

Format to generate the final output (Practice 4)
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Data Extraction Directly from 
the SCAG Model
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Steps to Extract Data Directly 
from the SCAG Model

Step 1: Navigate to the Project Location
» Purpose: Open the highway network and display project links
» TransCAD operations: 

 Open a geographic file 
 Navigate a map
 Show the node layer

Step 2: Assign and review project link IDs
» Purpose: Assign project link IDs to each link to be included in the AQ

analysis
» TransCAD operations: 

 Add a new field in the link attribute table
 Use the “info” tool to enter new link attributes
 Create a selection set by condition
 Create labels
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 3: Copy link attributes to the AQ Excel file
» Purpose: Clean and organize the highway network dataview to show 

only what will be copied to the AQ Excel file
» TransCAD operations:

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste

Step 4: Copy project link IDs to traffic assignment tables
» Purpose: Copy project link IDs from the highway network dataview to 

traffic assignment tables, which will be used in Step 5
» TransCAD operations: 

 Open a *.bin file
 Create a joint view 
 Fill a field using “Formula”
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 5: Copy traffic assignment results to the AQ
Excel file
» Purpose: Clean and organize traffic assignment tables to show only 

what will be copied to the AQ Excel file
» TransCAD operations

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the SCAG 2008 working geographic network file in TransCAD
 In TransCAD, File  Open, then in the file type dropdown next to ‘File name:’ select Geographic File (*.cdf; *.dbd) option
 Browse to the folder where the 2008 working geographic network file is: \AQ Training Material\SCAG 2012RTP 2008 BY Scenario\networks\Outputs
 Select the ‘scag_network_working.dbd’ and click ‘Open’ button. 

2. Navigate the map to show the SR-126 project area
 Use the tools on the toolbox to navigate the map to the SR-126 project area (red area in the two figures to the right)
 Use          to zoom in,          to zoom out and      to pan. If the toolbox is not shown, press F8 to bring it up
 If it is hard to locate the links, following these steps to locate one of the links on SR-126:
» Click         on the top ribbon in TransCAD
» On the “Find” popup window, select “Map Feature”, select “SCAG_BY08_links” as Layer, select “ID” as Field,

enter 25364 in Value, and Click “OK”. The map then zoom to show Link 25364, which is one of the links on
SR-126.

3. Show the node layer in the map to see where each link starts and ends
 In TransCAD, Map  Layers 
 On the Layers popup window, select Node and click the “Show Layer” button 
 On the Layers popup window, select the line layer (“SCAG_BY08_links”) to make it as the active layer
 Click the “Close” button to close the Layers popup window

Step 1: Navigate to the SR-126 Project Location
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Project Link IDs used in the Practice
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Practice 1: Create and fill the 2008 AQ Excel file

1. Add a new field for project link ID in the link attribute table
 In TransCAD, Dataview  Modify Table
 On the popup window, click button “Add Field” to add a new field
 Change Field Name to Proj_Link_ID
 Change Type to Integer (2 bytes)
 Click button “OK” to apply the change and close the popup window

2. Assign project link IDs one by one
 Start from the west end of the SR-126 project links
 Click      on the toolbox and click a project link 1 to open its

information window. If the toolbox is not shown, press F8 on 
keyboard to bring it up.

 On the information window, scroll down to the bottom, and enter 1 in 
Proj_Link_ID.

 Repeat the above two operations for the rest of links. The target is 
that all 13 links have the Proj_Link_ID as shown in the slide of 
“Project Link IDs used in the Practice”.

3. Create a selection set to make sure the project link IDs have been entered correctly.  
 On the selection toolbox, click          to open the “Select by Condition” popup window. If the selection toolbox is now shown, press F9 on the 

keyboard to bring it up.
 In the “Select by Condition” popup window, enter Proj_Link_ID > 0 in the textbox “Enter a Condition”, and click the “OK” button to create a new 

selection and close the popup window.
 Check whether the new selection set includes all 13 links. If not, repeat sub-step 2 (assign project link IDs) shown above to assign project link IDs to 

the missing links. Re-create the new selection set by using the condition of “Proj_Link_ID > 0”. Repeat until all 13 links are in the new selection set.
 Check whether the new selection includes any links that are not needed for the AQ analysis. If it does, use       on the toolbox and click on the link 

that should not be included to open its information window, from which delete the value in Proj_Link_ID. Re-create the new selection set by using the 
condition of “Proj_Link_ID > 0”. Repeat until the new selection does not include any links that are not needed for the AQ analysis.

Step 2: Assign and review project link IDs
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Practice 1: Create and fill the 2008 AQ Excel file

4. Label the links in the selection set with project link IDs to make sure the project link IDs have been entered correctly
 On the selection toolbox, click          to open the “Selection Sets” popup window. If the selection toolbox is now shown, press F9 on the keyboard to 

bring it up.
 On the “Selection Sets” popup window, click on the row for Selection, and click the 

button “Labels” to only label the links in the selection set. 
 On the new popup window “Labels”, select “Proj_Link_ID” for Field, enter 12 for 

Size, and click button “OK” to close the popup window “Labels”. 
 Click the “Close” button on the “Selection Sets” popup window to apply the labels and 

close the “Selection Sets” popup window. 

Step 2: Assign and review project link IDs (continued)

5. Review the label of project link IDs for each link in the selection set.  If the 
project link IDs for a link need to be changed, use      on the toolbox to 
bring up its information window and modify the value for “Proj_Link_ID”.
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the dataview for the SCAG highway network
 On the menu bar, click on          to open the dataview for the SCAG highway network

2. Show only selected links in the dataview
 On the menu bar, select “Selection” from the drop down list to, then only the links in the 

selection set are shown in the dataview

3. Show only fields to be included in the AQ Excel file
 Choose Dataview  Field Sets on the TransCAD menu to open the popup window “Field Sets”
 Click the “Add” button on the popup window “Field Sets”
 On the new popup window “Define Field Set”, click the “Clear” button to clear all fields from the right box
 Click on a field in the left box, then click the “Add>>” button to add it to the right box
 Repeat to add all fields of interest to the right box, as shown below
 Use the “Move Up” and “Move Down” button to adjust the order of fields in the right box to be in exact the same order as shown below
 “Filter” can be used to facilitate locating the field. The left box only shows the fields that contains the characters in the “Filter”
 Click the “OK” button and enter the field set name. Click “OK” to close the popup window “Field Sets” and apply the changes. 

Step 3: Copy link attributes to the AQ Excel file
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Practice 1: Create and fill the 2008 AQ Excel file

4. Sort the records by Project Link ID
 Right click any cell in the field of “Proj_Link_ID” to bring up a popup window as shown to the right, 

select “Sort Increasing” to sort the records in an increasing order of “Proj_Link_ID”

5. Open the AQ Excel file
 In Excel, open the AQ Excel file which is \AQ Training Material\AQ Data\ SR-126 Air Quality V1.xlsx
 This Excel file has the headers and the description of each link, but other fields are all empty

6. Copy link attributes from the dataview in TransCAD to the AQ Excel file
 On the dataview in TransCAD, click and drag to select all records and all but the first field
 Right click on the selected area, and click Copy on the popup window
 Right click on Cell E4 in Excel, and click on             on the popup window to paste to the AQ Excel file

7. Close the dataview in TransCAD by clicking on the upper right corner 

Step 3: Copy link attributes to the AQ Excel file (continued) 
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the Traffic Assignment File (am_flow.bin) in TransCAD
 In TransCAD, File  Open, then in the file type dropdown next to ‘File name:’ select Fixed-format Binary File (*.bin) option
 Browse to the folder where the 2008 traffic assignment bin files are located: \AQ Training Material\SCAG 2012RTP 2008 BY Scenario\Assign\Outputs
 Select the ‘am_flow.bin’ and click ‘Open’ button 

2. Add a new field for project link ID in the traffic assignment table
 In TransCAD, Dataview  Modify Table
 In the popup window, click button “Add Field” to add a new field
 Change Field Name to Proj_Link_ID
 Change Type to Integer (2 bytes)
 Click button “OK” to apply the change and close the popup window

3. Create a joint dataview
 In TransCAD, Dataview  Join to open the popup window “Join”
 On the popup window “Join”, specify Joining from Table and Field, and To Table and Field

based on the figure shown to the right
 Click button “OK” to apply the settings and close the popup window

4. Fill the “Proj_Link_ID” field in the traffic assignment table
 On the joint dataview, right click on the header of the last 

field “am_flow.Proj_Link_ID”, and click on “Fill”
 On the popup window “Fill”, choose “Formula”
 On the popup window “Formula”, select 

“SCAG_BY08_links.Proj_Link_ID” in the “Field List”
drop down list. “SCAG_BY08_links.Proj_Link_ID” can 
also be typed in the text box directly.

 Click the “OK” button on the popup window “Formula”
 Click the “OK” button on the popup window “Fill”
 Close the joint dataview.

Step 4: Copy the project link IDs to the traffic assignment table
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Practice 1: Create and fill the 2008 AQ Excel file

1. Make a selection set of links to be included in the AQ analysis in the traffic assignment table
 Make the dataview am_flow as the active window
 Uses the selection toolbox to select links to be included in the AQ analysis
 On the selection toolbox, click          to open the “Select by Condition” popup window. If the selection toolbox is now shown, press F9 on the keyboard to 

bring it up.
 On the “Select by Condition” popup window, enter Proj_Link_ID > 0 in the textbox “Enter a Condition”, and click the “OK” button to create a new 

selection and close the popup window.

2. Show only fields to be included in the AQ Excel file
 Choose Dataview  Fields on the TransCAD menu to open the popup window “Dataview Fields”
 On the popup window “Dataview Fields”, click the “Clear” button to clear all fields from the right box
 Click on a field in the left box, then click the “Add>>” button to add it to the right box
 Repeat to add all fields of interest to the right box, as shown below
 Use the “Move Up” and “Move Down” button to adjust the order of fields in the right box to be in exact the same order as shown below
 “Filter” can be used to facilitate locating the field. The left box only shows the fields that contains the characters in the “Filter”
 Click “OK” to close the popup window “Dataview Fields” and apply the changes. 

Step 5: Copy traffic assignment results to the AQ Excel file



26

Practice 1: Create and fill the 2008 AQ Excel file

4. Sort the records by Project Link ID
 Right click any cell in the field of “Proj_Link_ID” to bring up a popup window as shown to the right, 

select “Sort Increasing” to sort the records in an increasing order of “Proj_Link_ID”

5. Open the AQ Excel file (if it is not open)
 In Excel, open the AQ Excel file which is \AQ Training Material\AQ Data\ SR-126 Air Quality V1.xlsx

6. Copy traffic assignment results from the dataview in TransCAD to the AQ Excel file
 On the dataview in TransCAD, click and drag to select all records and fields of interest
 Right click on the selected area, and click Copy on the popup window
 Paste to the corresponding cells in the AQ Excel file

7. Close the traffic assignment dataview in TransCAD by clicking on the uper right corner 

8. Use formulas in Excel to calculate the “Truck Percent” and “Vehicle Miles Traveled” in the AQ Excel file
 “Truck Percent” = (“Light Heavy Duty Vehicles” + “Medium Heavy Duty Vehicles” 

+ “Heavy Heavy Duty Vehicles”) / “Total Vehicles”
 “Vehicle Miles Traveled” = “Length” * “Total Vehicles”

Step 5: Copy traffic assignment results to the AQ Excel file (continued)
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Work with Traffic Volumes not 
directly from SCAG Models



28

Work with Traffic Volumes not 
directly from SCAG Models

When the traffic volumes from SCAG models need to 
be adjusted
» Example: SCAG models consistently underestimate the traffic 

volumes on a corridor
» Solution: to apply a factor to traffic volumes from SCAG models

When the opening year or future year of a project is 
not modeled by SCAG. 
» Example: the opening year of SR-126 is 2022, and a 2022 SCAG 

model does not exist
» Solution: to interpolate or extrapolate based on existing SCAG 

models.
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Examples of Applying a Factor to 
SCAG Traffic Volumes

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝=Adjustment_Factor × 𝑉𝑉𝑖𝑖

2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 is the post processed 2035 traffic volume on Link 𝑖𝑖. 

𝑉𝑉𝑖𝑖
2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 is the 2035 traffic volume directly from SCAG models on 

Link 𝑖𝑖. 

Traffic volumes could be 
» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Examples of Interpolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2022−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)
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Examples of Extrapolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2040−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Overview of Practice 2
Practice 2 is to calculate the 2022 No Build traffic 
volumes by interpolating 
» the 2008 No Build traffic volumes
» the 2035 No Build traffic volumes

Practice 1 generated the 2008 No Build traffic 
volumes

Repeat Practice 1 on the 2035 working network and 
the 2035 traffic assignment results to get the 2035 No 
Build traffic volumes (we have done this for you)

All work is done in Excel
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Practice 2: Calculate the 2022 No Build Traffic Volumes by 
interpolating the 2008 and 2035 No Build Traffic Volumes

1. Open the Excel file that contains the 2008 and 2035 No Build traffic volumes
 The Excel file is: \AQ Training Material\AQ Data\SR-126 Air Quality V2.xlsx

2. Create a new sheet “2022 NB”

3. Copy the entire sheet “2035 NB” and paste to the sheet “2022 NB”, so that we have all the headers and descriptions
 In the sheet “2035 NB”, click the upper left corner of the spreadsheet to select the entire spreadsheet
 Press Ctrl + C on the keyboard to make a copy of the entire spreadsheet
 In the sheet “2022 NB”, click the cell A1 

 Press Ctrl + V on the keyboard to paste to the sheet “2022 NB”

4. In Excel, calculate the 2022 No Build traffic volumes by interpolating the 2008 and 2035 No Build traffic volumes
 Use the formula shown on the slide “Examples of Interpolation of Traffic Volumes” to calculate
 Need to calculate these traffic volumes for both AB and BA direction

 Total Vehicles
 Total PCE
 Light Heavy Duty Vehicles
 Medium Heavy Duty Vehicles
 Heavy Heavy Duty Vehicles

 Sample formula to be used in Excel
For cell Q4 in sheet “2022 NB”, the formula is ='2008 NB'!Q4+(2022-2008)/(2035-2008)*('2035 NB'!Q4-'2008 NB'!Q4)

5. In Excel sheet “2022 NB”, the columns for “Truck Percent” and “Vehicle Miles Traveled” should have been updated automatically since
these columns contain formulas. If not, use Excel formulas to update them. 
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Update Congested Speed
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Update Congested Speeds
Congested speed is calculated based on volume-
delay function

𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 =
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

1 + 𝛼𝛼 × ( 𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶)𝛽𝛽

Where:
𝛼𝛼 and 𝛽𝛽 are parameters
𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉: total PCE volume for a time period
Capacity: total capacity on all lanes for a time period
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Update Congested Speeds

Congested speed is not a linear function of volume, 
so it is the best to use the volume-delay function to 
update congested speeds
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Parameters for the Volume-Delay 
Function

Should be 4.0

From the SCAG model documentation:
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1. Open the Excel file that contains the 2008, 2035 and 2022 No Build traffic volumes
 The Excel file is: \AQ Training Material\AQ Data\SR-126 Air Quality V3.xlsx

2. In sheet “2022 NB”, calculate the “AB AM VOC” and “BA AM VOC”
 AB AM VOC = AB AM Total PCE / AB CAPA AM (e.g. the formula for cell AG4 is =R4/O4)
 BA AM VOC = BA AM Total PCE / BA CAPA AM (e.g. the formula for cell AJ6 is =Z6/P6)

3. In sheet “2022 NB”, determine the values for “AB AM Alpha”, “AB AM Beta”, “BA AM Alpha” and “BA AM Beta” based on the slide 
“Parameters for the Volume-Delay Function”, VOC, facility type and area type.
 Can use “Filter” in Excel to help group records with the same values for Alpha and Beta 

4. In sheet “2022 NB”, calculate the congested speed
 Sample formula to be used in Excel

The formula for cell U4 is =K4/(1+AF4*AE4^AG4)

Practice 3: Calculate the Congested Speeds for 2022 No Build Scenarios

1. Click here to highlight 
Row 3

2. Turn on the Filter

3. Click here to see the 
list of unique values for 
AB Facility Type

4. Only check the values that should 
be shown. In this example, only 
records with AB Facility Type = 40 or 
42 will be shown, so it is easy to treat 
them as a group. 

5. Can repeat step 3 and 4 for 
another column. For example, we 
can show only records with “AB 
Facility Type = 40 or 42” and “AB 
Area Type = 4”
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Format results to Generate 
the Final Output
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Review of the Procedures to 
Prepare Data for AQ Analysis
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)
» Define project links 
» Extract data from traffic assignment results

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2)

Update congested speeds for the interpolated / 
extrapolated traffic volumes (Practice 3)

Format results to generate the final output (Practice 4)

In current AQ Tool

Could be added to the AQ Tool

Could be added to the AQ Tool
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Review of the Manual Air Quality 
Data Extraction Procedures
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SR - 126
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The SR-126 Project

Project limit
» SR-126 from SR-150 to SR-23

Project
» Convert SR-126 from “continuous left turn arterial” 

to “fully divided arterial”

Opening Year
» 2022

Future Year
» 2040
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Air Quality Analysis Data Needs

Key information for an Air Quality (AQ) 
analysis

» Total Volume
» Truck Percent
» Congested Speed
» Vehicle Miles Traveled (VMT)
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Air Quality Analysis Data Needs
AQ Data for a Project 

Base Year

Opening Year No Build

Opening Year Build

Future Year No Build

Future Year Build

Base Year (2008 for SR-126)

Opening Year (2022 for SR-126)

Future Year (2040 for SR-126)
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SCAG Model Alternatives
AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build*

SCAG 2035 Build*

* For the SR-126 project, the official SCAG 2035 
model is the no build scenario, and a SCAG 
2035 build scenario model needs to be run (the 
traffic assignment step only).   
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build*

2040 Build*

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Interpolation

Interpolation

* See the next slide
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Extrapolation

Extrapolation
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2)

Update congested speeds for the interpolated / 
extrapolated traffic volumes (Practice 3)

Format to generate the final output (Practice 4)
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Data Extraction Directly from 
the SCAG Model
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Steps to Extract Data Directly 
from the SCAG Model

Step 1: Navigate to the Project Location
» Purpose: Open the highway network and display project links
» TransCAD operations: 

 Open a geographic file 
 Navigate a map
 Show the node layer

Step 2: Assign and review project link IDs
» Purpose: Assign project link IDs to each link to be included in the AQ

analysis
» TransCAD operations: 

 Add a new field in the link attribute table
 Use the “info” tool to enter new link attributes
 Create a selection set by condition
 Create labels
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 3: Copy link attributes to the AQ Excel file
» Purpose: Clean and organize the highway network dataview to show 

only what will be copied to the AQ Excel file
» TransCAD operations:

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste

Step 4: Copy project link IDs to traffic assignment tables
» Purpose: Copy project link IDs from the highway network dataview to 

traffic assignment tables, which will be used in Step 5
» TransCAD operations: 

 Open a *.bin file
 Create a joint view 
 Fill a field using “Formula”
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 5: Copy traffic assignment results to the AQ
Excel file
» Purpose: Clean and organize traffic assignment tables to show only 

what will be copied to the AQ Excel file
» TransCAD operations

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste
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Review of the AQ Procedure 
based on the SR-118 Project

Project limit
» SR-118 from SR-23 to SR-27

Project
» Four alternatives

Opening Year
» 2020 (for this practice)

Future Year
» 2035 (for this practice)
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SR - 118

Presenter
Presentation Notes
16 miles long
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Step 1 : Navigate to the Project 
Location

Purpose: Open the highway network and display 
project links

TransCAD operations: 
» Open the geographic file 

\AQ Training Material\SCAG 2012RTP 2008 BY 
Scenario\networks\Outputs\ scag_network_working.dbd

» Navigate the map
» Show the node layer
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Step 2: Assign and review project 
link IDs

Purpose: Assign project link IDs to each link to be included in 
the AQ analysis

Detailed Steps:
1. Add a new field “Proj_Link_ID” in the link attribute table
2. Select the 13 project links by pointing on each link
3. Use the “info” tool to enter “Proj_Link_ID” for each of the 13 links
4. Label “Proj_Link_ID” on the 13 links

Hints:
1. Dataview  Modify Table

2. Selection Toolbox 

3. Main Toolbox 
4. Selection Toolbox  
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Project Link IDs used in the Practice
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Step 3: Copy link attributes to the 
AQ Excel file

Purpose: Clean and organize the highway network dataview to 
show only what will be copied to the AQ Excel file
Detailed Steps:
1. Show only records of interest
2. Show only fields of interest (refer to “SR-118 Air Quality V1.xlsx” 

Column E to P to know what fields to show and the order of fields)
3. Sort records in TransCAD
4. Copy and paste (to “\ AQ Training Material\AQ Data\SR-118 Air 

Quality V1.xlsx”)

Hints:
1.

2. Dataview Fields / Fields Sets, please include “Proj_Link_ID”, filter

3. Right Click  Sort Increasing
4. Ctrl + C, then Ctrl + V
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Step 4: Copy project link IDs to 
traffic assignment tables
Purpose: Clean and organize the highway network dataview to show only 
what will be copied to the AQ Excel file

Detailed Steps:
1. Open the Traffic Assignment File (pm_flow.bin) in TransCAD
2. Add “Proj_Link_ID” in the traffic assignment table
3. Create a joint dataview
4. Fill the “Proj_Link_ID” field in the traffic assignment table

Hints:
1. “AQ Training Material\SCAG 2012RTP 2008 BY Scenario\Assign\Outputs”

2. Dataview  Modify Table, join from “ID” to “ID1”

3. Dataview  Join
4. Right Click  Fill Formula
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Step 5: Copy traffic assignment 
results to the AQ Excel file
Purpose: Clean and organize traffic assignment tables to show only what 
will be copied to the AQ Excel file

Detailed Steps:
1. Show only records of interest
2. Show only fields of interest (refer to “SR-118 Air Quality V1.xlsx” Column Q to 

AF to know what fields to show and the order of fields)
3. Sort records in TransCAD
4. Copy and paste (to “\ AQ Training Material\AQ Data\SR-118 Air Quality 

V1.xlsx”)
5. Calculate the “Truck Percent” and “Vehicle Miles Traveled”

Hints:
1. Selection  Select by Condition, the condition is Proj_Link_ID > 0
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Work with Traffic Volumes not 
directly from SCAG Models
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Work with Traffic Volumes not 
directly from SCAG Models

When the traffic volumes from SCAG models need to 
be adjusted
» Example: SCAG models consistently underestimate the traffic 

volumes on a corridor
» Solution: to apply a factor to traffic volumes from SCAG models

When the opening year or future year of a project is 
not modeled by SCAG. 
» Example: the opening year of SR-126 is 2022, and a 2022 SCAG 

model does not exist
» Solution: to interpolate or extrapolate based on existing SCAG 

models.
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Examples of Applying a Factor to 
SCAG Traffic Volumes

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝=Adjustment_Factor × 𝑉𝑉𝑖𝑖

2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 is the post processed 2035 traffic volume on Link 𝑖𝑖. 

𝑉𝑉𝑖𝑖
2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 is the 2035 traffic volume directly from SCAG models on 

Link 𝑖𝑖. 

Traffic volumes could be 
» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Examples of Interpolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2022−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)
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Examples of Extrapolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2040−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Overview of Practice 2
Practice 2 is to calculate the 2020 No Build traffic 
volumes by interpolating 
» the 2008 No Build traffic volumes
» the 2035 No Build traffic volumes

Practice 1 generated the 2008 No Build traffic 
volumes

Repeat Practice 1 on the 2035 working network and 
the 2035 traffic assignment results to get the 2035 No 
Build traffic volumes (we have done this for you)

All work is done in Excel
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Steps of Practice 2
Detailed Steps:
1. Open “\ AQ Training Material\AQ Data\SR-118 Air Quality V2.xlsx”

2. Fill Columns Q to U, and Columns Y to AC in Sheet “2020 NB” by interpolating 
traffic volumes from “2008 NB” and “2035 NB”

3. Calculate the Columns V, X, AD and AF (“Truck Percent” and “Vehicle Miles 
Traveled”) in Sheet “2020 NB”

Hints:

2. 𝑉𝑉𝑖𝑖2020=𝑉𝑉𝑖𝑖2008 + 2020−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)



30

Update Congested Speed
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Update Congested Speeds
Congested speed is calculated based on volume-
delay function

𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 =
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

1 + 𝛼𝛼 × ( 𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶)𝛽𝛽

Where:
𝛼𝛼 and 𝛽𝛽 are parameters
𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉: total PCE volume for a time period
Capacity: total capacity on all lanes for a time period
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Parameters for the Volume-Delay 
Function

Should be 4.0

From the SCAG model documentation:
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Steps of Practice 3
Detailed Steps:
1. Open “\ AQ Training Material\AQ Data\SR-118 Air Quality V3.xlsx”

2. Calculate the VOC and fill Columns AG and AJ in Sheet “2020 NB”

3. Fill Alpha and Beta in Columns AH, AI, AK and AL in Sheet “2020 NB”

4. Calculate the congested speeds and fill Columns W and AE in Sheet 
“2020NB”

Hints:

2. Use the total PCE, instead of total vehicles in VOC 

4. 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 =
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

1 + 𝛼𝛼 × ( 𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶)𝛽𝛽
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Format results to Generate 
the Final Output
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Review of the Procedures to 
Prepare Data for AQ Analysis
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)
» Define project links 
» Extract data from traffic assignment results

Apply a factor to adjust modeled traffic volumes, and 
update the congested speed (Practice 3)

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2), and update the congested 
speed (Practice 3)

In previous version of the AQ Tool

New function added to the AQ Tool

New function added to the AQ Tool



 

515 S.  F igueroa Street ,  Sui te  1975 
Los Angeles,  CA  90071 

 te l  213-372-3009 www.camsys.com fax  213-372-3010 

Memorandum 

TO: Caltrans District 7 

FROM: Chao Wang, Sean McAtee 

DATE: April 7, 2017 

RE: SR-118 Air Quality Data Preparation 

At your request, CS has been providing training and assistance with extraction of air quality data 
for the SR-118 corridor in Ventura County. We have prepared an analysis of this corridor 
consistent with the specifications discussed previously. This updated SR-118 AQ data analysis is 
based on the most recently adopted SCAG travel model, the SCAG 2016 Regional Transportation 
Plan (RTP) model.  

 

Project Limits 

The SR-118 project is in Ventura County in Moorpark and Simi Valley on SR-23 from 0.8 mile 
north of Tierra Rejada Road undercrossing to New Los Angeles Avenue undercrossing, and on 
SR-118 from New Los Angeles Avenue undercrossing to 0.4 mile west of Tapo Canyon Road 
undercrossing. The SR-118 project limits are shown in Figure 1. 

 

Figure 1: SR-118 Project Limits 
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Project Alternatives 

The SR-118 project has three alternatives, as described below: 

 Alternative 1: No-Build Alternative. 

 Alternative 2: Alternative proposes the following improvements: 

 Add one mixed flow lane from New Los Angeles Ave. to Collins Dr. in each direction. 

 Add two mixed flow lane from Collins Dr. to Madera Rd. in each direction. 

 Add one mixed flow lane from Madera Rd. to Tapo Canyon Rd in each direction. 

 Construct soundwall and median barrier. 

 Widen 11 structures:  Arroyo Simi Bridge and overhead (OH); Princeton Ave. 
undercrossing (UC); Alamos Cyn Rd UC; Madera Rd. UC; Caldwell Ave. UC; Erringer Rd. 
UC; Dry Cyn. Channel; Sycamore Dr. UC; Galena Ave. UC; Sequoia Ave. UC; Arroyo Del 
Tapo Channel. 

  
 Alternative 3:  Alternative proposes the following improvements 

  Add one mixed flcow lane from Arroyo Simi Bridge to Tapo Canyon Rd. in each direction. 

 Restripe the Arroyo Simi Bridge from two to three non-standard lanes in each direction. 

 Reconstruct the inside shoulder and median of SR-23/SR-118 connectors from two to 
three non-standard lanes in each direction 

 Construct soundwall and median barrier. 

 Widen 10 structures.  Same proposed structures in Alternative 2, excluding Arroyo Simi 
Bridge. 

 

Model Analysis Years and Phases 

The model analysis years and phases for the SR-118 project are summarized below. 

 Existing Year: 2014 

 Opening Year 1: 2025 

 In Year 2025, the Phase 1 of the project will be completed 

 In Phase 1, only the east bound of SR-118 will be widen. 

 Opening Year 2: 2030 
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 In Year 2030, the Phase 2 of the project will be completed 

 In Phase 2, both the east bound and the west bound of SR-118 will be widen. 

 Horizon Year: 2040 

 

Model Alternatives for the Air Quality Analysis 

Ten model alternatives are required for the Air Quality (AQ) Analysis, as listed below. 

 Existing 2014 No Build 

 Opening  2025 No Build 

 Opening 2025 Build Alternative 2 Phase 1 

 Opening 2025 Build Alternative 3 Phase 1 

 Opening 2030 No Build 

 Opening 2030 Build Alternative 2 Phase 2 

 Opening 2030 Build Alternative 3 Phase 2 

 Horizon 2040 No Build 

 Horizon 2040 Build Alternative 2 Phase 2 

 Horizon 2040 Build Alternative 3 Phase 2 

 

The official SCAG 2016 RTP model provides the 2012 model, the 2016 model, and the 2040 
model. The results for all immediate years are interpolated or extrapolated based on these three 
model years. Table 1 summaries how the ten model alternatives listed above are obtained based 
on the 2012, 2016 and 2040 models. For example, the first row in Table 1 shows that the results 
for Existing 2014 No Build (2014 NB) are interpolated based on the results for the 2012 NB and 
the 2016 NB.  
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Table 1: Model Runs to Obtain the Ten Model Alternatives for the AQ Analysis1 

  
2012 
Models 

2016 Models  2040 Models 

   NB  NB  A2P1  A2P2  A3P1  A3P2  NB  A2P1  A2P2  A3P1  A3P2 

2014NB  X  X                            

2025NB     X              X             

2025A2P1        X              X          

2025A3P1              X              X    

2030NB     X              X             

2030A2P2           X              X       

2030A3P2                 X              X 

2040NB                    X             

2040A2P2                          X       

2040A3P2                                X 
 

Table 1 shows that eleven SCAG model runs (scenarios) are needed. They are: 

 2012 No Build 

 2016 No Build 

 2016 Build Alternative 2 Phase 1 

 2016 Build Alternative 2 Phase 2 

 2016 Build Alternative 3 Phase 1 

 2016 Build Alternative 3 Phase 2 

 2040 No Build 

 2040 Build Alternative 2 Phase 1 

 2040 Build Alternative 2 Phase 2 

 2040 Build Alternative 3 Phase 1 

 2040 Build Alternative 3 Phase 2 

 

SCAG Model Runs 

Since the SR-118 project will not affect the regional travel pattern and the mode choice pattern, 
only traffic assignment was run for each scenario.  

                                                 
1 In Table 1, A means Alternative and P means Phase. For example, A2P1 means Alternative 2 Phase 1.  
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The procedures for each SCAG model run are: 

 Code the highway network 

 Alternative 1 (No Build): no changes are needed. 

 Alternative 2 Phase 1: Starting from the No Build highway network, add one lane to the 
east bound of the freeway for all freeway links in the project limit, plus add one additional 
lane (two lanes in total) to the east bound of the freeway between Collins Dr. to Madera 
Rd.  

 Alternative 2 Phase 2: Starting from the No Build highway network, add one lane to both 
bounds of the freeway for all freeway links in the project limit, plus add one additional lane 
(two lanes in total) to both bounds of the freeway between Collins Dr. to Madera Rd. 

 Alternative 3 Phase 1: Starting from the No Build highway network, add one lane to the 
east bound of the freeway for all freeway links in the project limit.  

 Alternative 3 Phase 2: Starting from the No Build highway network, add one lane to both 
bounds of the freeway for all freeway links in the project limit.  

 

 Run network initialization on the SCAG model user interface to re-calculate the freeway 
speeds and capacities 

 Run traffic assignment with turn penalties 

 The official SCAG model does not implement any turn penalties. However, turn penalties 
are needed for many ramps in the SR-118 project to make sure these ramps are 
represented correctly in the highway network. Figure 2 shows examples of prohibited 
turns. The curved arrows in Figure 2 are turn movements that were prohibited. 

 

 
Figure 2: Example of Prohibited Turns 
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 Caltrans D7 provided the turn penalty table they have been using to CS. CS reviewed and 
revised this table. 

 Turn penalties were added to the TransCAD network file (*.net file), and traffic assignment 
for all five time periods was run.  

 

The highway network for the official 2012 SCAG model is the same as the highway network for 
the 2012 No Build scenario, and the traffic assignment results for the official 2012 SCAG model 
are ready. However, the traffic assignment for the 2012 No Build scenario still needs to run 
because turn penalties needs to be applied in traffic assignment, to be consistent with results 
from other scenarios. Based on the same reason, the 2016 No Build scenario and the 2040 No 
Build scenario were also run. In total, eleven scenarios were run. 

 

Data Extraction and Interpolation 

The AQ data extraction tool was used to extract and interpolate data from the raw SCAG traffic 
assignment results. An important input file to this tool is the project link file, which contains the 
TransCAD link IDs for all links that should be included in the analysis of the SR-118 project. It 
also contains some other link attributes, such as road names, facility types, begin of link 
descriptions, and end of link descriptions.  

Caltrans D7 provided the SR-118 project link file. CS reviewed this file and made some 
modifications, including, 

 Updated the TransCAD link ID to be consistent with the SCAG 2016 RTP. The SR-118 
project link file provided by Caltrans D7 was based on the SCAG 2012 RTP model, which 
has different highway network from that for the SCAG 2016 RTP. So the project link ID list 
has been updated to be consistent with the SCAG 2016 RTP.  

 Added more links to facilitate the study of intersections. Caltrans D7 wants to study major 
intersections close to the SR-118 project. All intersection legs (including Tier 1 Centroid 
Connectors) for these major intersections have been added to the project link ID list to 
facilitate this study.  

 Added more links from parallel local roads. Adding more lanes on SR-118 attracts trips 
from parallel local roads, therefore reducing their traffic. More links from these parallel 
local road have been added to the project link ID list to reflect the impact of the SR-118 
project. 

 Corrected begin of link descriptions and end of link descriptions on some links. 

 

The new project link ID list includes the 263 links demonstrated in Figure 3 (the previous list 
included 229 links).   
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Figure 3: Links defining the SR-118 Project 

 

At Caltrans D7’s request, CS modified the AQ data extraction tool to report the link Volume Over 
Capacity (VOC). The Excel template file was modified accordingly.  

 

Final Output 

The CSV files generated from the AQ data extraction tool were copied to the Excel template file 
to create the final output files. The final output files are attached as the ten files shown below. 
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